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Asia FIX

Source: BlackRock, as of 31 March 2026. Reference to LUMSTRUU, LGNMTRUU, LUCMTRUU, JCLOAAAT, JPEI9BTR Index.

Source: Bloomberg as of 9 January 2026, JP Morgan as 31 December 2025. Securitized process for illustrative purposes only.

The securitized ETF toolkit

Today, the securitized ETF toolkit is broad and diverse, and goes far beyond traditional residential mortgage 

backed securities (MBS). Additionally, active ETFs offer flexible solutions to tap into the income opportunity, 

from actively managed MBS exposures, to a one-ticker approach across securitized sectors, spanning 

residential and commercial MBS, CLOs, as well as other asset backed securities.

Anchored in no small part by HALO assets - real-economy exposures with unique drivers of risk offering 

diversification benefits - securitized assets present a compelling income opportunity within fixed income. 

Securitized assets offer elevated spread premiums relative to comparable corporate credit (Figure 1), while 

current yield levels across the securitized range remain at attractive levels relative to history (Figure 2).

The AI mega force means that investors are considering the impact of AI on companies and their ability to repay 

debt if business models are to be disrupted. Amidst this environment, Heavy Assets, Low Obsolescence (HALO) 

assets tied to the real economy, such as housing, buildings and transport, are less exposed to AI-led disruption. 

In fixed income, securitized assets stand out as debt backed by real assets and durable cash flows.

Securitized assets are backed by a pool of financial assets e.g. mortgages with similar characteristics, rather 

than a single issuer’s credit. The underlying assets are bundled and packaged into securities, and sold to 

investors who receive principal and interest payments over time. These securities are split into tranches 

representing differing levels of risk and payment priority, with cash flows distributed via a waterfall structure.

A HALO over securitized assets

Exposure US Residential MBS
US Residential MBS 
(GNMA-guaranteed)

US Commercial MBS
AAA-rated
USD CLOs

BBB-B Rated
USD CLOs

Index
Bloomberg US

MBS Index
Bloomberg US GNMA 

Bond Index
Bloomberg US CMBS 

(ERISA only) Index
JPM CLOIE
AAA Index

JPM CLOIE High Quality 
Mezzanine Index

Collateral
Agency-backed 

residential 
mortgages

GNMA-backed 
residential mortgages

Commercial 
mortgages

Corporate loans Corporate loans

Coupon Fixed Fixed Fixed Floating Floating

Yield 4.88 4.91 4.61 4.99 9.88

Duration 5.52 5.43 3.79 0.06 0.01
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BBB
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different 
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(SPV)
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Managers)
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To find out more about Securitized ETFs, contact your iShares representative.

60
74

60

110 100

145 138 145
122 130

S
p

re
a

d
 (

b
p

s
)

0%

20%

40%

60%

80%

100%

3Y
USD

IG

5Y
USD

IG

10Y
USD

IG

30Y
USD

IG

CLO
AAA

CLO
AA

CLO
A

ABS
AAA

ABS
AA

ABS A

%
 o

f 
A

s
s

e
ts

% of last 20 years at lower yield levels than current

Excluding post-2021 period

Figure 1 Figure 2

MKTG0426-5432350-EXP0427-1/6



Guides
Go to View and check the “Guides” box to see page 
margins and columns. This feature will help align 
items on the page.  

Text
Adjust text sizes as needed. Bigger is better. Use 
only BLACK or WHITE text. Use font size and/or 
the Extrabold, Bold, or Body font weights instead of 
color to differentiate.

Layouts
Go to the Layout menu on the Home tab to access 
additional page layout options. 

Charts
Axis lines: .25pt black

Base line: 1pt black

Trend lines: 2pt (minimum) thick lines are standard

Bars: thick bars are standard style

Text labels: 8pt BLK Fort (minimum) 

Tables
Divider lines: .25pt black

Bottom border: 1pt black

Avoid vertical gridlines when possible.

Use black for header row shading as the standard 
choice. Highlight key information by shading rows 
and columns with colors from the primary brand 
color palette. 

When your document lacks any color in the overall 
design, a good option is to add color by shading the 
header bar of tables with colors from the primary 
brand palette. Use this approach sparingly. 

Compliance
If you are creating financial promotions/marketing 
materials, please consult the applicable content 
policies and approval procedures in your region.

Helpful hints

2

FOR PROFESSIONAL, ACCREDITED, INSTITUTIONAL AND WHOLESALE INVESTORS USE 

ONLY – NOT FOR PUBLIC DISTRIBUTION (PLEASE READ IMPORTANT DISCLOSURES)

iShares flow update

01

Flows moderated in March 2026 to +$9B amid the ongoing conflict in the Middle East, though Q1 still 

closed on a strong footing with +$47B in inflows (+40% vs. Q1’25). Against an uncertain backdrop, 

demand was heavily skewed toward U.S. Treasuries (+$16.9B), and inflation linkers (+$1.4B), while 

outflows were concentrated in riskier sectors -  HY (-$5.6B), EM (-$3.6B), and IG (-$3.5B).

02
U.S. Treasuries recorded their strongest monthly inflows since March 2023, supported by renewed 

USD strength. Demand remained skewed to short duration, with the flagship 0–3M exposure gathering 

+$8.6B, while the broad and 7-10Y maturity exposures saw robust flows (+$5.2B and +$1.1B, respectively).

03
Persisting inflation concerns drove continued demand for inflation-linked products, with flows 

concentrated in shorter-duration exposures. The 0–5Y USD TIPS segment attracted +$1.0B, while EUR 

and Global inflation-linked exposures also saw elevated inflows (+$288M and +$181M, respectively).

04

De-risking was evident across credit and EM. Credit outflows were broad-based across currencies but 

sharply skewed toward HY, while EM saw outflows across both hard and local currency exposures. That 

said, precision exposures remained resilient, with our Brazilian government bond exposure attracting 

+$175M, while China added +$50M.

05
iBonds continued to see steady demand (+$887M) amidst elevated yields, led by IG (+$532M) and 

government bond strategies (+$259M). Active flows moderated overall, albeit CLO exposures, 

particularly AAA, saw strong interest, attracting over +$400M, the highest on record.

Top/bottom iShares bond ETF sector flows
Top 5 Exposures MTD Flow ($M) % of AUM

U.S. Treasury - Short Dur 11,019 6%

U.S. Treasury - Broad 5,703 12%

U.S. Treasury - Inter Dur 1,673 2%

Municipal - Long Dur 1,366 99%

Multi Sector - Broad 1,042 0%

Top 5 Exposures Total 20,803

Bottom 5 Exposures MTD Flow ($M) % of AUM

High Yield - Broad (5,093) -7%

Investment Grade - Broad (3,775) -3%

Emerging Markets - Broad (3,540) -8%

U.S. Treasury - Long Dur (1,853) -3%

Covered Bond - Broad (432) -25%

Bottom 5 Exposures Total (14,693)

Top 5 Exposures YTD ($M) % of AUM

U.S. Treasury - Short Dur 17,943 10%

Multi Sector - Broad 10,705 4%

U.S. Treasury - Broad 7,738 16%

U.S. Treasury - Inter Dur 4,807 5%

Investment Grade - Fixed Maturities 2,843 8%

Top 5 Exposures Total 44,036

   Bottom 5 Exposures YTD ($M) % of AUM

High Yield - Broad (6,247) -8%

U.S. Treasury - Long Dur (6,096) -10%

Investment Grade - Broad (775) -1%

Emerging Markets - Broad (456) -1%

High Yield - Short Dur (371) -5%

Bottom 5 Exposures Total (294)

25,262

1
1

,9
9

0

3,993

25,653

262 1,9162,897
8,705

(6,699) (6,301)

2,897 4,0754,308
12,010

456

(6,457)

iShares Flow YTD (US$M) Industry Flow YTD (US$M)

46,954

69,719

U.S. Treasury

Multi Sector/Agg

Investment Grade

Mortgages

Non-US Sovereign

High Yield

Inflation

Municipal

Emerging Markets

Source: BlackRock, as of March 31 2026. Reference to $ refers to USD.
iShares and industry ETF flows encompass globally listed products. ‘Broad’ categories reference blended maturity products EM flows in the top tight chart are ex-China.

MKTG0426-5432350-EXP0427-2/6



Guides
Go to View and check the “Guides” box to see page 
margins and columns. This feature will help align 
items on the page.  

Text
Adjust text sizes as needed. Bigger is better. Use 
only BLACK or WHITE text. Use font size and/or 
the Extrabold, Bold, or Body font weights instead of 
color to differentiate.

Layouts
Go to the Layout menu on the Home tab to access 
additional page layout options. 

Charts
Axis lines: .25pt black

Base line: 1pt black

Trend lines: 2pt (minimum) thick lines are standard

Bars: thick bars are standard style

Text labels: 8pt BLK Fort (minimum) 

Tables
Divider lines: .25pt black

Bottom border: 1pt black

Avoid vertical gridlines when possible.

Use black for header row shading as the standard 
choice. Highlight key information by shading rows 
and columns with colors from the primary brand 
color palette. 

When your document lacks any color in the overall 
design, a good option is to add color by shading the 
header bar of tables with colors from the primary 
brand palette. Use this approach sparingly. 

Compliance
If you are creating financial promotions/marketing 
materials, please consult the applicable content 
policies and approval procedures in your region.

Helpful hints

3

FOR PROFESSIONAL, ACCREDITED, INSTITUTIONAL AND WHOLESALE INVESTORS USE 

ONLY – NOT FOR PUBLIC DISTRIBUTION (PLEASE READ IMPORTANT DISCLOSURES)

Bond market update

Global rates sold off sharply in March as oil prices surged following the outbreak of the Middle East 

conflict, fueling renewed inflation concerns that drove yields to multi-year highs across major 

economies. In the US, 2Y Treasury yields peaked at 4.0% before settling at 3.8% as the Fed held rates 

at 3.50%-3.75%, with several officials describing future rate decisions as “two-sided”. In Europe, the 

ECB and BOE both held rates steady, as Eurozone inflation jumped to 2.5% on energy shocks. 

Elsewhere in Asia, the RBA continued its hiking cycle by raising its cash rate to 4.10% while 10Y JGB 

yields climbed past 2.4% despite the BOJ maintaining its policy stance.

Rates

Credit

The conflict in the Middle East dominated the macro backdrop in March, with escalation at end-

February driving a sharp surge in oil prices - marking the largest quarterly jump in Brent since the 

Gulf War - and triggering a broad cross-asset selloff. Credit spreads widened in tandem, with 

underperformance concentrated in HY. In the US, HY spreads widened 26bps versus 5bps in IG. In 

Asia, HY spreads saw a similar pattern and widened by 47bps, while IG spreads remained flat.

Source: Bloomberg, as of 31 March 2026. See notes at the bottom for indices used. Past performance is not a reliable indicator of current or future results and should not be the sole factor of 
consideration when selecting a product or strategy. Indices are unmanaged and one cannot invest directly in an index.

FX Forward Premium or Cost is associated mainly with short-term interest rate differential between domestic and 

foreign currency (& currency basis). This impact can be positive or negative depending on the currency pair. 

Source: Bloomberg, as of 31 March 2026. Indices used: BBG Global Aggregate Index (USD, unhedged), BBG US Aggregate Index (USD), NOMURA BPI (JPY), BBG US Treasury Index (USD), 
BBG Agency MBS Index (USD), BBG China Treasury & Policy Bank Index (CNY), BBG US IG Corporate Index (USD), BBG US HY Corporate Index (USD), JP Morgan Asia Credit IG Index (USD), JP 
Morgan Asia Credit HY Index (USD), JP Morgan EMBI Global Diversified Index (USD), JP Morgan GBI-EM Index (USD, unhedged). Reference to the company name mentioned in this 
communications is merely for explaining the investment strategy, and should not be construed as investment advice or investment recommendation of those companies.

Asset class in review

Market recap

FX hedge cost monitor

Currency to Hedge (Forward tenor - 3M)

CCY USD EUR JPY KRW AUD CNY SGD

USD 0.00% 1.66% 3.06% 1.13% -0.56% 2.34% 2.50%

EUR -1.66% 0.00% 1.40% -0.53% -2.22% 0.68% 0.84%

JPY -3.06% -1.40% 0.00% -1.92% -3.61% -0.71% -0.56%

KRW -1.13% 0.53% 1.92% 0.00% -1.69% 1.21% 1.37%

AUD 0.56% 2.22% 3.61% 1.69% 0.00% 2.90% 3.06%

CNY -2.34% -0.68% 0.71% -1.21% -2.90% 0.00% 0.16%

SGD -2.50% -0.84% 0.56% -1.37% -3.06% -0.16% 0.00%

In
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Index YTD QTD MTD Mar-end ΔMTD ΔYTD Mar-end ΔMTD ΔYTD

Global Aggregate -1.07% -1.07% -3.07% 3.78% 0.40% 0.26%

US Aggregate -0.05% -0.05% -1.76% 4.57% 0.41% 0.25%

Japan FI, N-BPI -1.67% -1.67% -1.83% 2.19% 0.22% 0.25%

US Treasury -0.04% -0.04% -1.74% 4.14% 0.39% 0.25%

Agency MBS 0.40% 0.40% -1.65% 4.83% 0.45% 0.20%

China(CGB+PB) 0.81% 0.81% 0.24% 1.63% -0.04% -0.10%

US IG Corporates -0.54% -0.54% -1.98% 5.14% 0.41% 0.33% 89 5 11

US HY Corporates -0.50% -0.50% -1.18% 7.40% 0.69% 0.87% 317 26 51

Asia IG, JACI IG -0.51% -0.51% -1.57% 5.10% 0.39% 0.33% 111 0 9

Asia HY, JACI HY -0.13% -0.13% -3.07% 8.59% 1.08% 0.52% 433 47 21

EM HC, EMBI GD -1.26% -1.26% -3.27% 7.31% 0.66% 0.51% 289 30 35

EM LC, GBI-EM -2.25% -2.25% -5.55% 6.37% 0.54% 0.50% - - -

Yield level
Spread level (bps)

(credit only)

Aggregate

Treasury &  

Agency

Credit 

(IG & HY)

Emerging 

Markets

Total Return

MKTG0426-5432350-EXP0427-3/6



Guides
Go to View and check the “Guides” box to see page 
margins and columns. This feature will help align 
items on the page.  

Text
Adjust text sizes as needed. Bigger is better. Use 
only BLACK or WHITE text. Use font size and/or 
the Extrabold, Bold, or Body font weights instead of 
color to differentiate.

Layouts
Go to the Layout menu on the Home tab to access 
additional page layout options. 

Charts
Axis lines: .25pt black

Base line: 1pt black

Trend lines: 2pt (minimum) thick lines are standard

Bars: thick bars are standard style

Text labels: 8pt BLK Fort (minimum) 

Tables
Divider lines: .25pt black

Bottom border: 1pt black

Avoid vertical gridlines when possible.

Use black for header row shading as the standard 
choice. Highlight key information by shading rows 
and columns with colors from the primary brand 
color palette. 

When your document lacks any color in the overall 
design, a good option is to add color by shading the 
header bar of tables with colors from the primary 
brand palette. Use this approach sparingly. 

Compliance
If you are creating financial promotions/marketing 
materials, please consult the applicable content 
policies and approval procedures in your region.

Helpful hints

4

Source: BlackRock, “Innovation meets opportunity”, as of April 2025. There is no guarantee that any forecasts made will come to pass. All $ in USD unless otherwise stated.

Innovation Meets Opportunity
How years of constant fixed income ETF innovation are empowering investors to 
navigate today’s markets and build portfolios for the new era

Index Your Bonds with Asia Credit
Asia bond markets definitely have a part to play in the next leg of 

growth in index and ETF adoption. As investors continue to move 

beyond the “active versus passive” debate, constant product 

innovation will offer increasingly precise sources of potential 

returns, and help lead more investors to embrace bond index 

building blocks alongside high conviction active strategies in 

pursuit of optimal portfolio outcomes.

In this Asia-focused “Index Your Bonds” paper, we spotlight 

iShares Asia Credit exposures, provide insights on how they are 

managed in practice, and discuss how innovations such as ESG 

integration will make indexing an integral part of investing in Asia 

fixed income.

FOR PROFESSIONAL, ACCREDITED, INSTITUTIONAL AND WHOLESALE INVESTORS USE 

ONLY – NOT FOR PUBLIC DISTRIBUTION (PLEASE READ IMPORTANT DISCLOSURES)

Last year, our whitepaper “No Time to Yield” discussed 
why investors may want to consider getting cash off the 
sidelines and employing bond ETFs in the new market 
regime.

In our latest paper “Innovation Meets Opportunity”, we 
highlight how accelerating bond ETF innovation has 
equipped investors with a robust ETF toolkit that simply 
did not exist the last time yields were at these levels, and 
how investors can use bond ETFs to navigate both 
today’s and tomorrow’s market environments.

Did you know?

• Client demand for fixed income ETFs is driving significant asset growth with record flows 
in 2024 and on track to reach $6 trillion in assets under management (AUM) by 2030, if not 
sooner. Globally, bond ETFs experienced the highest organic asset growth (20%) of any other 
asset class or investment vehicle last year. And so far in 2025, client adoption continues to 
accelerate, with assets up 22% on an annualized basis. 

• The flywheel of bond ETF innovation is powering this growth, helping more investors to 
access exposures and outcomes that were previously difficult to access. Last year a record 
420 bond ETFs were launched, enabling investors to tailor their fixed income investments in 
ways previously unthinkable. 

• The ever-increasing toolkit allows investors to take advantage of a generational 
opportunity in fixed income. Yields are higher than they have been in 20 years. Globally, some 
80% of fixed income assets now yield over 4% and we believe they’ll remain elevated for the 
foreseeable future. 

• iShares has been spearheading innovation in bond ETFs for over two decades. Our diverse 
and evolving product set supports clients globally to navigate across market environments, 
with more modern, precise ways to reach nearly every part of the fixed income market. As the 
experts in portfolio construction with a strong heritage in risk management, we understand the 
tools and exposures that investors require to thrive in a changing world.

2

3

1

4

DOWNLOAD THE PAPER >

DOWNLOAD THE PAPER >
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Important disclosures

This material is provided for educational purposes only and is not intended to be relied upon as a forecast, research or investment 
advice, and is not a recommendation, offer or solicitation to buy or sell any securities or iShares Funds, nor to adopt any investment 
strategy. The opinions expressed are subject to change. References to specific securities, asset classes and financial markets are for 
illustrative purposes only and are not intended to be and should not be interpreted as recommendations. There are risks associated 
with investing, including loss of principal. The value of investments involving exposure to foreign currencies can be affected by 
exchange rate movements. Reliance upon information in this material is at the sole risk and discretion of the reader. The material was 
prepared without regard to specific objectives, financial situation or needs of any investor. You are reminded to refer to the relevant 
prospectus for specific risk considerations which are available from BlackRock or the iShares websites.

This material may contain “forward-looking” information that is not purely historical in nature. Such information may include, among 
other things, projections, forecasts, and estimates of yields or returns. No representation is made that any performance presented will 
be achieved by any BlackRock or iShares Funds, or that every assumption made in achieving, calculating or presenting either the 
forward-looking information or any historical performance information herein has been considered or stated in preparing this 
material. Any changes to assumptions that may have been made in preparing this material could have a material impact on the 
investment returns that are presented herein. Past performance is not a reliable indicator of current or future results and should not 
be the sole factor of consideration when selecting a product or strategy.

The information and opinions contained in this material are derived from proprietary and nonproprietary sources deemed by 
BlackRock to be reliable, are not necessarily all-inclusive and are not guaranteed as to accuracy.

In Hong Kong, this material is issued by BlackRock Asset Management North Asia Limited and has not been reviewed by the 
Securities and Futures Commission of Hong Kong. This material is for distribution to "Professional Investors" (as defined in the 
Securities and Futures Ordinance (Cap.571 of the laws of Hong Kong) and any rules made under that ordinance) and should not be 
relied upon by any other persons or redistributed to retail clients in Hong Kong.

In Singapore, this is issued by BlackRock (Singapore) Limited (Co. registration no. 200010143N) for use only with accredited and 
institutional investors as defined in Section 4A of the Securities and Futures Act, Chapter 289 of Singapore. This advertisement or 
publication has not been reviewed by the Monetary Authority of Singapore.

In South Korea, this information is issued by BlackRock Investment (Korea) Limited. This material is for distribution to the Qualified 
Professional Investors (as defined in the Financial Investment Services and Capital Market Act and its sub-regulations) and for 
information or educational purposes only, and does not constitute investment advice or an offer or solicitation to purchase or sells in 
any securities or any investment strategies.

In Taiwan, independently operated by BlackRock Investment Management (Taiwan) Limited. Address: 28F., No. 100, Songren Rd., 
Xinyi Dist., Taipei City 110, Taiwan. Tel: (02)23261600.

In Australia & New Zealand, issued by BlackRock Investment Management (Australia) Limited ABN 13 006 165 975, AFSL 230 523 
(BIMAL) for the exclusive use of the recipient, which warrants by receipt of this material that it is a wholesale client as defined under 
the Australian Corporations Act 2001 (Cth) and the New Zealand Financial Advisers Act 2008 respectively.

BIMAL is not licensed by a New Zealand regulator to provide ‘Financial Advice Service’, 'Investment manager under an FMC offer' or 
‘Keeping, investing, administering, or managing money, securities, or investment portfolios on behalf of other persons’. BIMAL’s 
registration on the New Zealand register of financial service providers does not mean that BIMAL is subject to active regulation or 
oversight by a New Zealand regulator.

This material provides general advice only and does not take into account your individual objectives, financial situation, needs or 
circumstances. Before making any investment decision, you should therefore assess whether the material is appropriate for you and 
obtain financial advice tailored to you having regard to your individual objectives, financial situation, needs and circumstances. Refer 
to BIMAL’s Financial Services Guide on its website for more information. This material is not a financial product recommendation or 
an offer or solicitation with respect to the purchase or sale of any financial product in any jurisdiction.

Information provided is for illustrative and informational purposes and is subject to change. It has not been approved by any 
regulator.

This material is not intended for distribution to, or use by, any person or entity in any jurisdiction or country where such distribution or 
use would be contrary to local law or regulation. BIMAL is a part of the global BlackRock Group which comprises of financial product 
issuers and investment managers around the world. BIMAL is the issuer of financial products and acts as an investment manager in 
Australia. BIMAL does not offer financial products to persons in New Zealand who are retail investors (as that term is defined in the 
Financial Markets Conduct Act 2013 (FMCA)). This material does not constitute or relate to such an offer. To the extent that this 
material does constitute or relate to such an offer of financial products, the offer is only made to, and capable of acceptance by, 
persons in New Zealand who are wholesale investors (as that term is defined in the FMCA).

BIMAL, its officers, employees and agents believe that the information in this material and the sources on which it is based (which 
may be sourced from third parties) are correct as at the date of publication. While every care has been taken in the preparation of this 
material, no warranty of accuracy or reliability is given and no responsibility for the information is accepted by BIMAL, its officers, 
employees or agents. Except where contrary to law, BIMAL excludes all liability for this information.

Any investment is subject to investment risk, including delays on the payment of withdrawal proceeds and the loss of income or the 
principal invested. While any forecasts, estimates and opinions in this material are made on a reasonable basis, actual future results 
and operations may differ materially from the forecasts, estimates and opinions set out in this material. No guarantee as to the 
repayment of capital or the performance of any product or rate of return referred to in this material is made by BIMAL or any entity in 
the BlackRock group of companies.

No part of this material may be reproduced or distributed in any manner without the prior written permission of BIMAL.
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Guides
Go to View and check the “Guides” box to see page 
margins and columns. This feature will help align 
items on the page.  

Text
Adjust text sizes as needed. Bigger is better. Use 
only BLACK or WHITE text. Use font size and/or 
the Extrabold, Bold, or Body font weights instead of 
color to differentiate.

Layouts
Go to the Layout menu on the Home tab to access 
additional page layout options. 

Charts
Axis lines: .25pt black

Base line: 1pt black

Trend lines: 2pt (minimum) thick lines are standard

Bars: thick bars are standard style

Text labels: 8pt BLK Fort (minimum) 

Tables
Divider lines: .25pt black

Bottom border: 1pt black

Avoid vertical gridlines when possible.

Use black for header row shading as the standard 
choice. Highlight key information by shading rows 
and columns with colors from the primary brand 
color palette. 

When your document lacks any color in the overall 
design, a good option is to add color by shading the 
header bar of tables with colors from the primary 
brand palette. Use this approach sparingly. 

Compliance
If you are creating financial promotions/marketing 
materials, please consult the applicable content 
policies and approval procedures in your region.

Helpful hints

In China, this material may not be distributed to individuals resident in the People's Republic of China ("PRC", for such purposes, not 
applicable to Hong Kong, Macau and Taiwan) or entities registered in the PRC unless such parties have received all the required PRC 
government approvals to participate in any investment or receive any investment advisory or investment management services.

For Other Countries in APAC: this material is provided for your informational purposes only and must not be distributed to any other 
persons or redistributed. This material is issued for Institutional Investors only (or professional/sophisticated/qualified investors as 
such term may apply in local jurisdictions) and does not constitute investment advice or an offer or solicitation to purchase or sell in 
any securities, BlackRock funds or any investment strategy nor shall any securities be offered or sold to any person in any jurisdiction 
in which an offer, solicitation, purchase or sale would be unlawful under the securities laws of such jurisdiction.

The information provided here is not intended to constitute financial, tax, legal or accounting advice. You should consult your own 
advisers on such matters. BlackRock does not guarantee the suitability or potential value of any particular investment. Investment 
involves risk including possible loss of principal. International investing involves risks, including risks related to foreign currency, 
limited liquidity, less government regulation, and the possibility of substantial volatility due to adverse political, economic or other 
developments. These risks are often heightened for investments in emerging/developing markets or smaller capital markets.

The information provided here is not intended to constitute financial, tax, legal or accounting advice. You should consult your own 
advisers on such matters.

THIS MATERIAL IS HIGHLY CONFIDENTIAL AND IS NOT TO BE REPRODUCED OR DISTRIBUTED TO PERSONS OTHER THAN THE 
RECIPIENT. 

©2026 BlackRock, Inc. or its affiliates. All Rights Reserved. iShares® and BlackRock® are registered trademarks of BlackRock, Inc. or its 
affiliates in the United States and elsewhere. All other trademarks, servicemarks or registered trademarks are the property of their 
respective owners.
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